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 دیافزارهای مارولس دیزاینر و کلو تریآموزش طراحی لباس با نرم

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 قسمت اول:

 libraryافزار مارولس: توضیح قسمت نرم

: برای انتخاب کردن الگو، جابجا کردن الگو، بزرگ و کوچک transform pattern: ابزار 2Dدر قسمت 

الگو. اگر بخواهیم مقدار مشخصی بزرگ و کوچک یا چرخانده شود، همانطور که چپ  کردن و چرخاندن

 کنیم.شود که مقدار دلخواه را آنجا وارد میکنیم و یک پنجره باز میایم، راست کلیک میکلید را نگه داشته

اگر بخواهیم  : کنترل کردن نقاط و خطها در الگو، جابجا کردن هر نقطه و خط الگو. edit patternابزار 

 کنیم.مقدار مشخصی جابجا شود قبل از رها کردن چپ کلید، راست کلیک می

 قسمت دوم:

Edit curvatureتبدیل خط صاف به منحنی : 

Edit curve pointها کند و دوباره همان نقطهنی کردن خط صاف یک نقطه ایجاد می: همزمان با منح

 قابل ادیت است.

Add point/ Split lineتقسیم کردن خط به تعداد و  جاد نقطه روی خطوط الگو در محل دلخواه،: ای

 راست کلیک کردن روی خط مورد نظربا  تقسیم کردن خط مورد نظر به تعداد مساوی؛ ی دلخواه،اندازه

Smooth curveدلخواه بدهیم باید  یکند. اگر بخواهیم اندازهشه های تیز را به منحنی تبدیل می: گو

و بعد از این ابزار استفاده کنیم یا قبل از رها کردن ها را مشخص کرده نقطه  Add pointار قبلش با ابز

 چپ کلیک، راست کلیک کنیم.

Slash & Spreadایجاد برش و اوزمان : 

اگر محل مشخصی بخواهیم  توانیم یا زاویه بدهیم یا مقدار اوزمان را مشخص کنیم.با راست کلیک کردن می

 قطه ایجاد کنیم بعد اوزمان دهیم.ن add pointبا ابزار  باز هم باید اول

توانیم با کلیک کردن روی آن خط دوباره استفاده کنیم و دوباره اوزمان از خطی که قبلا اوزمان دادیم می

 دهیم.

Polygon ترسیم کردن هر الگو و شکلی که بخواهیم. با نگه داشتن :shift شود. خطوط راهنما مشخص می

 ی مشخص بدهیم.توانیم اندازهلیک کردن میبا راست ک

Rectangleبا کلیک روی صفحه میتوانیم در بخش : رسم مربع و مستطیل .size ی دلخواه بدهیم و اندازه

 ی دلخواه کپی کنیم.یک شکل را به تعداد دلخواه و با فاصله و زوایه replicateدر بخش 

Ellipseرسم دایره و بیضی : 



 قسمت سوم:

Internal polygon/line فقط روی الگو می توانیم خط یا شکل ایجاد کنیم. با دابل کلیک کردن، ابزار :

 شود.از دستور خارج می

خط را انتخاب کرده، راست  transform patternیا  edit patternبعد برای برش دادن الگو با ابزار 

 زنیم.را می cutکنیم و کلیک می

Internal rectangleع و مستطیل روی الگو. خارج از الگو کاربرد ندارد.: رسم مرب 

Internal ellipseرسم دایره و بیضی روی الگو : 

Dartایجاد پنس روی الگو : 

Segment sewing.برای مشخص کردن اینکه کدام درز به کدام درز دوخته شود : 

کوچکتر بخواهد  هایرگتر به درزاگر یک درز بز کنیم.درز را انتخاب کرده بعد درز دوم را انتخاب میاول یک 

را نگه داشته و درزهای کوچکتر را انتخاب  shiftکنیم بعد انتخاب می رادوخته شود اول درز بزرگتر 

 کنیم.می

Free sewing وقتی درزهایی که می خواهیم به هم بدوزیم هر دو از چند جا برش داشته باشد از این ابزار :

 کنیم.استفاده می

 قسمت چهارم:

Edit sewingهایی که قبلا انجام دادیم با کلیک کردن روی نقاط ابتدا یا انتهای درز. : تغییر دادن دوخت

 ؛ی دوختها به طور همزمان، پنهان کردن یک دوختپاک کردن دوخت، از بین بردن خط برش، دیدن همه

 همه با راست کلیک کردن روی درز موردنظر.

Show 2D sewingکه کدام درزها بهم دوخته شده است.: فقط برای دیدن این 

Check sewing length چک کردن اینکه درزهای بهم دوخته شده از لحاظ طولی باهم برابر هستند یا :

 نه.

که کلیک کنیم تنظیمات  fabricی توضیح قسمت تنظیمات پارچه: در قسمت راست بالا روی لایه

property editor شود. برای پارچه باز میTexture، Normal map ،color ،opacity ،Type ،

Reflection 

 



 قسمت پنجم:

Edit texture.برای ادیت کردن تکسچری که گذاشتیم، بزرگ و کوچک کردن، چرخاندن، و جابجا کردن : 

Graphic (2D pattern) برای گذاشتن عکس یا آرم یا نوشته روی لباس، بهتر است پسوند :PNG  و

 ترنسپرنت باشد.

Transform graphicبرای بزرگ و کوچک کردن و چرخاندن و جابجا کردن عکس روی لباس : 

 شود مثل تکسچر بافت بدهیم یا رنگش را عوض کنیم.عکس را هم می

Show 2D textureتوانیم برای خلوت شدن الگو پنهان کنیم.: تکسچرهایی که داریم را می 

Physical propertyتوان جنسیت پارچه را از ه را داریم، که می: در قسمت تنظیمات فبریک این گزین

 لحاظ فیزیکی تعیین کنیم که مثل همان پارچه واکنش نشان دهد.

Display > Environment > Show wind controller    از این قسمت می توان در فضای سه بعدی

 منبع وزش باد قرار داد.

 قسمت شش:

Segment topstitchزهای موردنظر را انتخاب کرده و رو دوزی در قسمت سه : ابزار رو دوزی تزیینی، در

 شود.بعدی دیده می

 ی موردنظر را انتخاب کرده و در، لایهtopstitch، سربرگ object browserدر قسمت سمت راست 

 شود.ربوطه باز میقسمت پایین تنظیمات م

Offset ی درز، ی خط دوخت از لبهفاصلهshape ،length ،space ،3D 

Free topstitch اگر بخواهیم رو دوزی یکسره باشد و دور درزها دور بزند. در این قسمت هم می تواند :

 گوشه های دوخت را گرد کرد.

Pleatکنیم و تعداد پلیسه، : ابزار پلیسه کردن الگو، از قبل باید محاسبات را انجام داده بعد الگو را رسم می

 کنیم.طول هر پلیسه و نوع پلیسه را انتخاب می

Pleats sewing :دوخت پلیسه 

علاوه بر  Symmetric patternکند. الگو را قرینه کپی می copy ،paste ،mirror pasteتوضیح 

 شود.قرینه کپی کردن، هر عملیاتی که روی یک الگو انجام دهیم روی الگوی قرینه هم خود بخود اعمال می



Symmetric pattern (with sewing)ارد قبل، اگر در یک الگو دو برش را بدوزیم این : علاوه بر مو

 د.شودوخت در الگوی قرینه هم اعمال می

Cut & sewشود.: همزمان با برش دادن دوخت هم انجام می 

Offset as internal lineکند.ی داده شده ایجاد می: دور تا دور داخل الگو یک خط مثل الگو با فاصله 

Offset pattern outline کند. با ابزار دور الگو خط ایجاد می بیرون دورتا: ازedit pattern  می توانیم

 فقط یک خط را انتخاب کرده و به  همان خط اضافه کنیم مثلا برای جادکمه.

 قسمت هفت: 

 Toolbarتوضیح 

File > Add ی دیگر اضافه کنیم.توانیم یک پروژه را به پروژهمی 

 و چگونه مشاهده کردن آن. animationد. افزودن توضیحات بیشتر برای ایجاد کردن با

 قسمت هشت:

رسم  2Dشروع اولین پروژه، آواتار را انتخاب کرده، نصف الگوی جلو را به صورت حدودی در قسمت 

گیریم. از کل آن دوباره کپی گرفته و برای الگوی پشت در کنیم. بعد یک کپی قرینه همراه دوخت میمی

 گیریم.نظر می

دهیم و با راست کلیک کردن و ت را در قسمت سه بعدی جابجا کرده و پشت مانکن قرار میالگوی پش

 گردانیم.الگو را به رو برمی Flip Horizontallyی گزینه

زنیم. اگر تغییراتی لازم داشت انجام داده و دوباره را می simulateبعد دوخت درزها را مشخص کرده و 

simulate کنیم.می 

درز را انتخاب کرده، راست کلیک و  Edit sewingبردن درز وسط جلو و پشت، با ابزار  برای از بین

Merge 

 Deleteخط را انتخاب کرده و  Traceبرای اینکه رد درز را از بین ببریم با ابزار 

اگر بخواهیم یک برش دقیقا مثل خط الگو کنار آن ایجاد کنیم مثلا دور حلقه آستین، خط منحنی حلقه 

ی مورد نظر را میزنیم و فاصله Offset as internal lineی را انتخاب کرده، راست کلیک و گزینه آستین

 کنیم.می Cut & Sewبعد برشها را  دهیم.از لبه را به تنظیمات می



انتخاب کنیم، فقط کافی است روی یک نقطه دابل  Free sewingاگر بخواهیم دورتادور یک الگو را با 

 کلیک کنیم.

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 قسمت نه:

ی لباس از آواتار، در قسمت سه بعدی روی آواتار کلیک کرده، و در قسمت تنظیمات برای کم کردن فاصله

 کنیم.را کم می Skin Offsetمربوطه 

را زیاد   intensityکنیم و زنیم و تنظیمات سه بعدی رو دوزی را روشن میبعد دور برشها رودوزی می

 30کنیم، حدود می



منبع نور را تنظیم  Display > Environment > Show light controllerبرای نورپردازی از مسیر 

 کنیم.می

توانیم یک عکس انتخاب ، میDisplay > Format 3D Backgroundبرای تنظیمات بکگراند از مسیر 

 زمینه را برای خروجی گرفتن تغییر دهیمکرده یا رنگ پس

کنیم. کادر مورد نظر را انتخاب می File > Snapshot > 3D Windowمسیر  برای خروجی گرفتن از

 کنیم.انتخاب کرده و سیو می

 قسمت ده:

 کنیم.می Simulateی دوم، الگوهای جلو و پشت را مثل قبل طراحی کرده و پروژه

 Show Line ها را روی الگو ببینیم، روی صفحه راست کلیک کرده،برای اینکه در قسمت دوبعدی اندازه

Length کنیم یا از روی صفحه کلید رو انتخاب میshift+Z زنیم.را می 

 Convert to curveروی پوینت راست کلیک،  edit patternبرای منحنی کردن یک پوینت، با ابزار 

pattern. 

 Avatarکشیم. برای قرار دادن آستین روی دست، در قسمت سه بعدی روی الگوی آستین را هم می

Display  نگه داشته وShow Arrangement points  ی مناسب و آستین را با نقطه یمکنرا فعال می

 زنیم.را می simulateو کنیم. بعد دوختها را مشخص کرده مچ می

 کنیم.گیریم و آستین بعدی هم وصل میاز آستین کپی قرینه با دوخت می

 قسمت یازده:

 شود.ها که از دو نوع و دو طرح مختلف استفاده میپارچه بندیی دوم. لایهی پروژهادامه

، در قسمت تنظیمات مربوط به پارچه، Normal mapبرای بزرگ و کوچک کردن 

Transformations> Normal map توان کم و زیاد کرد.طول و عرض را می 

خط مورد نظر را  Edit Patternاگر بخواهیم یک درز حالت کش دوزی یا چین سوزنی داشته باشد، با 

 کنیم.را فعال می Elasticانتخاب کرده و در قسمت تنظیمات، 

در  ثل مغزی یا نوار اریب ایجاد کنیم؛حالتی م ،ی یک درز یا داخل یک برشبرای اینکه دور تا دور لبه

و در کنیم کنیم و درز را از همان قسمت سه بعدی انتخاب میاستفاده می Pipingقسمت سه بعدی از ابزار 

 توان ضخامت آن را تغییر داد.آخر دابل کلیک. در قسمت تنظیمات مربوطه می



 Add| Thickness، به Simulation propertiesدر قسمت  به پارچه؛دادن ضخامت برای 

(Rendering)  دهیم و برای نشان دادن ضخامت در قسمت سه بعدی، ضخامت میThick Surface  را

 کنیم.روشن می

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 قسمت دوازده:

  Avatar display > Show Avatar Measurementsهای آواتار: ی سوم. برای دیدن اندازهپروژه

 قسمت سیزده:

 Editتوانیم با ابزار برای کامل شدن یک الگوی نصفه، اگر به قرینه همراه با دوخت نیاز نداشتیم، می

Pattern نتخاب کرده، راست کلیک و خواهیم از آن قرینه شود را اخطی که میUnfold. 



ی الگوها را فریز کرده، میتوانیم پنهان کنیم و حتی آواتار را نیز پنهان کنیم. به برای گره زدن کمربند، بقیه

کنیم. برای را از روی صفحه کلید نگه داشته و هرجا بخواهیم پین کنیم کلیک می Wنیاز داریم.  Pinابزار 

کنیم تا کردن، کمربند را فریز می Simulateکنیم. بعد از مین کار را تکرار میبرطرف کردن پین دوباره ه

 باز نشود.

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 قسمت چهارده: 

 ی چهارم، دامن دکمه دار.پروژه

 قسمت پانزده: 

 ابزار دکمه و جا دکمه و تنظیمات مربوط به آن



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 قسمت شانزده:

 ی پنج، دامن مجلسی.پروژه

ی مساوی با فاصله Offset internalدو تا خط با  ی پایین لباس یا لب آستین،خورده ی تارای ایجاد لبهب

 کنیم.در قسمت سه بعدی استفاده می Fold Arrangementابزار  ازکنیم. ایجاد می

 قسمت هفده: 

 Zipperایجاد زیپ با ابزار 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 قسمت هجده:

 دامن شلواریبلوز و  ی شش،پروژه

 Simulateگیرد را طراحی و برای اینکه دو تا لباس روی هم داشته باشیم، اول لباسی که زیر قرار می

 کنیم. کنیم و بعد لباس را فریز میمی

 دوزیم.ایم میخط کمر دامن شلواری را به خطی که روی بلوز ایجاد کرده

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 قسمت نوزده:

 Thicknessبلوز و شلوار داخل هم نرود، در قسمت تنظیمات پارچه بلوز  هایبرای اینکه پارچه

(Collision) کنیم مثلا سه و نیم.را زیاد می 

، ضخامت Cut & Sewبرای ایجاد کردن حالت کشباف ضخیمتر، دور یقه و آستین را خط ایجاد کرده بعد 

 کنیم.این قسمت ها را یکی بیشتر می

کنیم و اگر روی زمین نیست به روی پوزیشن آواتار را عوض می Particle Distanceقبل از کم کردن 

 کنیم.زمین منتقل می



یک حرکت مربوط به خود آواتار انتخاب  Library > Motionsبرای انیمیشن کردن، ابتدا از قسمت 

ویم. رمی Animationبه  Simulationزنیم. از قسمت بالای سمت راست صفحه از کنیم و اوکی را میمی

 توانیم انیمیشن را ببینیم.کردن می Playزنیم تا ابتدا رکورد کند و بعد با ن را میعلامت دوربی

 Tack onو  واتار بچسبانیمبه آخط برای این است که لباس را با یک  Line Tack on Avatarابزار 

Avatar باس از روی آواتار حرکت چسبانیم تا موقع انیمیشن لبه آواتار می یا نقاط لباس را با یک نقطه

 نکند یا نیفتد.

 قسمت بیست:

 برای خروجی گرفتن. یک محیط آتلیه مانند آماده در فایل زیپ قرار داده شده. 3D Maxاستفاده از 

 Settings > Userدی مکس باشد، باید از مسیر: ل تریس برای اینکه محیط سه بعدی مثدر مارول

Settings > View Controls 3، رویD Max .باشد 

 باشد و اوکی. cmروی  Scaleکنیم. فقط می Fbx ،Exportپروژه را با پسوند 

 20همه را بیشتر کرده روی  Saturationکنیم. متریالهای مربوط به پوست را در فتوشاپ باز می

رویم و اوکی. را می Filter > 3D > Generate Bump Mapکنیم. حالا مسیر گذاریم بعد سیو میمی

Save As کنیم. میCtrl + Z  زده و اینبار مسیرFilter > 3D > Generate Normal Map  را

 دهیم. ی قسمتهای پوست اینکار را انجام می. برای بقیهSave Asرویم. اوکی و می

 قسمت بیست و یک:

 Ctrl+L کنیم ودر فتوشاپ باز کرده، بکگراندش را مشکی می هست را PNGفایل مربوط به مو که با پسوند 

 کنیم.سیو می JPGبریم تا تصویر موها سفید شود و با پسوند می را تا آخر Output levelsزنیم و را می

کنیم. در اینجا رویم و فایل مربوط به آواتار را باز میرا می File > import > importمسیر  3d maxدر 

 بعضی قسمتها نیاز به ادیت دارد.

 Editable meshی باز شده زنیم. در پنجرهرا می modifyنجره سمت راست روی موها کلیک کرده، در پ

> element کنیم.ی روی مو را پاک میکنیم و لایهکنیم و دوباره روی موها کلیک میرا انتخاب می  

، surface propertiesکند. در قسمت زنیم کل سطح را انتخاب نمیرا می elementبرای کفشها وقتی 

ID کنیم.خواهیم پاک شود را انتخاب کرده و پاک میی که میمتریال 

 کنیم.را باز می toolbar ،material editorدر نوار 



کنیم و سپس از ابتدا آواتار را انتخاب کرده، بعد در متریال ادیتور، بخش مربوط به کل پوست را انتخاب می

 شود.متریال به آواتار اعمال می زنیم و اینرا می Assign Material to Selectionنوار بالا 

حالا اگر بخواهیم متریال پوست را تغییر دهیم، روی تک تک فایل ها دابل کلیک کرده، در قسمت 

Bitmap parametersدهیم. هر کدام را در قسمت مربوط به خود ، مسیر مورد نظر خود را قرار می

 کنیم.جایگزین می

داریم، دابل کلیک کرده یا  coronamtlا، یک متریال به اسم در ستون سمت چپ، قسمت متریالهای کرون

 شود. روی آن دابل کلیک کرده دوباره تا تنظیماتکشیم روی صفحه و یک بیس متریال برای ما باز میمی

basic options  .در قسمت راست باز شود 

Diffuse color تکسچر پوست. رنگ اصلی، یا طرح آبجکت است مثلا رنگ پارچه یا طرح پارچه یا 

را  general ،Bitmapشود. اولین گزینه از ، اگر کلیک کنیم یک لیست باز میcolorروی کادر کنار 

 کنیم.می openکنیم. در اینجا طرح یا تکسچر مورد نظر را انتخاب کرده و انتخاب می

 Show shadedبالا برای اینکه تغییرات را روی آواتار ببینیم، روی متریال دابل کلیک کرده، در نوار 

material in viewportزنیم.، را می 

Reflection  ،برای ایجاد برقش و انعکاس نور روی متریال هستlevel  میزان رفلکت وGlossiness 

 توان رنگ انعکاس را تغییر داد.می colorکند. با تغییر مقدار محو شدگی رفلکت را کنترل می

 قسمت بیست و دو:

 گذاریم.هم می توان به جای رنگ عکس استفاده کرد، مثلا برای پوست، نرمال مپ می Reflectionبرای 

Opacityکند. اگر برای ، شفافیت متریال را کم و زیاد میOpacity  عکس بدهیم، باید سیاه و سفید باشد

کند. شود و قسمتهای سفید تغییر نمیو به این صورت است که جاهایی که مشکی است شفافیت کم می

 مثلا برای پارچه های توری کاربرد دارد.

Displacement  برای ایجاد بافت روی پارچه است، در قسمتtexture که  کنیمعکس را انتخاب می

 کنیم.شدت را کم و زیاد می Maxو  Minباید سیاه و سفید باشد و با 

دهیم و گی مو را میعکس رن Diffuseکنیم، در قسمت ایجاد می Coronamtlمتریال مربوط به مو: یک 

 گذاریم.می Opacityعکس سیاه و سفید را در قسمت 

 گذاریم.می Diffuseمتریال چشم: عکس چشم را در قسمت 

 دهیم.و اگر خواستیم به آن رفلکت می دهیم یا طرحرنگ می Diffuseکفش: در قسمت 



است و چند متریال دارد،  کنیم که چند تکهمتریال پارچه: وقتی یک لباس را در تری دی مکس باز می

 آوریم.ی متریال نبود، با قطره چکان متریال را میخودش یک متریال استاندارد دارد. اگر در صفحه

به  Ambient colorکنیم. را جایگزین متریالهای استاندارد خود لباس می Coronamtlما متریال 

diffuse color شود. منتقل می 

 قسمت بیست و سه:

توانیم زوم نرم داشته می Ctrlو  Altتوانیم آواتار را بچرخانیم. با وسط کلید، می Altط موس و با کلید وس

گیرد. برای نمای پرسپکتیو، روی یک از چهار نمایی که داریم هرکدام انتخاب باشد همان را رندر می باشیم.

 زنیم.را می Pنما کلید 

 Material Editorکنار  Render setupتنظیمات مربوط به 

 سایز نهایی کادر رندر است. Common ،Output sizeدر سربرگ 

 Corona highرا روی  Denoisingو  45تا  35کنیم تعیین می Scene ،Pass limitدر سربرگ 

quality برای سیو کردن روی زنیم. گذاریم. بعد رندر را میمیJPG  گذاشته، عددOverride  2/2را روی  

 گذاریم و سیو.می

 توانیم در فتوشاپ مقداری ادیت کنیم. کنتراست نور و رنگ را زیاد کنیم.می

 قسمت بیست و چهار:

 دی مکس.توضیح در مورد محیط تری

کنیم گیری را باز میتنظیمات مربوط به واحد اندازه Customize > Units setupابتدا از مسیر 

  کنیم.متر را انتخاب میو سانتی Metricو

بجکت، آن را انتخاب کرده، راست کلیک آدن، چرخاندن و بزرگ و کوچک کردن یک برای حرکت دا

کنیم. اگر بخواهیم به مقدار مشخصی تغییرات دهیم، را انتخاب می Scaleیا  Move ،Rotateکنیم و می

 کند.ی کوچک هست که تنظیمات مربوطه را باز میها یک پنجرهکنار این گزینه

توان رسم یا لمانهای مختلفی که میاست، لیستی از ا   +که به شکل  Createدر قسمت راست، در سربرگ 

 کند. بعد از رسم یک شکل تاآبجکتهای سه بعدی رسم می Geometryبه محیط اضافه کرد وجود دارد. 

 شود.یم از دستور ترسیم خارج نمیزمانیکه راست کلیک نکن

Shapes کند.اشکال دو بعدی ایجاد می 



Lights انیم منبع نور در صحنه قرار دهیم. قبل از انتخاب کردن نوع نور، ابتدا موتور رندر که تومی

Corona شود. هست را انتخاب کرده، بعد نورهای مربوط به آن لیست میCorona sun  نور طبیعی

)کنار  Modifyنور مصنوعی است. که بعد از رسم هرکدام در سربرگ  Corona lightخورشید و 

Createتوان تنظیمات مربوط به آن را دید.( می 

Modify ی قسمت لیستی از همهاین دهد. در تنظیمات مربوط به هر چیزی که در صحنه است را نشان می

 Fn + F4با زدن  توان تنظیمات مربوطه را باز کرد.آبجکتهای روی صحنه است که با کلیک روی هرکدام می

 مشاهده کرد.توان خطوط سگمنت روی آبجکت را می F4یا 

برای آنکه بدون ، Render Setupدر دهد. را بزنیم کادر رندر را نشان می shift + Fاگر  ،در هر ویوپورتی

 زنیم.را می Scene ،start interactive، تغییرات را در رندر ببینیم، در سربرگ Renderزدن 

تراست رنگ هست که یک سری تنظیمات مربوط به کنتراست، نور صحنه و کن Cameraدر سربرگ 

 توان تغییر داد.می

 :پنجقسمت بیست و 

 بلوز و شلوار پیلی دار. هفت یپروژه

کنیم، در قسمت سه بعدی روی آن راست  simulateخواهیم پیلی را ها. موقعی که میتوضیح کامل پیلی

 زنیم.را می Strengthenکلیک کرده و 

 :ششقسمت بیست و 

شود. و هر تعداد که پیلی سه برابر درزی باشد که به آن دوخته می خورد، بایدقسمتی که پیلی می

 خواهیم، تقسیم بندی ما باید سه برابر تعداد پیلی باشد.می

دار را در نظر بگیریم. اگر باید قسمت پیلی 195متر است، سه برابر آن یعنی سانتی 65مثلا دور کمر 

 کنیم.می 24 تا پیلی داشته باشیم، خط را تقسیم بر 8بخواهیم 

 :هفتقسمت بیست و 

به  Offsetی رودوزی، روی الگو به همان فاصله ها فرو رفته و طبیعی تر باشد؛وزیبرای اینکه خط رود

 .گذاریممی 200کنیم، روی را بیشتر می Fold Angleکنیم و در تنظیمات، سمت داخل ایجاد می



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 :شتقسمت بیست و ه

به داخل  Offsetتا زدن آستین. روی الگو در قسمت دو بعدی دو تا  ونیک و دامن چروک.، تی هشتپروژه

کنیم و فریز. بعد در کات می ار است ی آستین نزدیکترکنیم. خطی که به لبهی پهنای تا، ایجاد میبه اندازه

ی پایین را دوباره زنیم. بعد برش لبهبه بالا تا می Fold Arrangementقسمت سه بعدی خط بالاتر را با 

ی کنیم و گزینهدوزیم و در قسمت سه بعدی از فریز خارج کرده، راست کلیک میبه آستین می

Supperimpose (over) زنیم و بعد را میsimulate. 

 گیریم تا نیاز نباشد دوباره تا بزنیم.اول یک آستین را تا زده و بعد از آن کپی قرینه می



 :نهقسمت بیست و 

 دی مکس. متریال پردازی پروژه در تریکش دوزی. آموزش 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 :سیقسمت 

 Editتوان روی بدن خود آواتار خط کشید. ابزار در قسمت سه بعدی که می Line (Avatar)کاربردهای 

line (Avatar)  با ابزار ،Flatten توان خط ها را تبدیل به الگو کرد.می 

 توان خط کشید و ادیت کرد.ی لباسی که تن آواتار است میرو Line (3D Pattern)ابزار 



 کنیم.راست کلیک می 3Dتوضیح موارد مربوط به زمانیکه در قسمت 

 :و یک قسمت سی

 طراحی بادی ورزشی، ی نهپروژه

 :دوقسمت سی و 

 ی بادی ورزشی.ی پروژهادامه

 آن.و ذخیره کردن  Show X-Ray Joitsتغییر پوزیشن آواتار از طریق 

 قسمت سی و سه:

 کاپشن پافر مردانه.، ی دهپروژه

برای اینکه خطی که روی الگو کشیدیم ابتدا و انتهای آن با خطوط دور الگو مماس شود، خط را انتخاب 

 Extend/Trim to pattern outlineکرده، راست کلیک و 



داشته باشد، خط  Pointطع ی خطهایی که از رویش رد شده در قسمتهای تقابرای اینکه خطی که با همه

 Add Point to Intersectionرا انتخاب کرده، راست کلیک و 

بعدی اگر بخواهیم الگویی را که بعد از تغییرات کج شده، صاف کنیم، روی الگو راست کلیک  در قسمت دو

 زنیم.را می Y-Axisیا  rotate > X-Axisکرده، 

پی کنیم که تمام خطهای آن به هم دوخته باشد و با هم لینک برای اینکه یک الگو دقیقا مثل الگوی اصلی ک

زنیم و در قسمت سه بعدی الگوی کپی را می Layer clone (Over)باشند، روی الگو راست کلیک کرده، 

 گیرد.شده رو قرار می

 کنیم.را زیاد می Pressureبرای ایجاد حالت پفی 

 

 

 

 

 

 

 

 

 قسمت سی و چهار:

 ی پافر مردانهادامه

 قسمت سی و پنج:

 Convert to holeی پافر مردانه. برای جیبها بعد از رسم کادر جیب، راست کلیک و ادامه

 قسمت سی و شش:

 دی مکس. متریال پردازی پافر در تری

از عکس زیپ ادیت شده که دو طرفش را مشکی  سپسدهیم. می Bumpعکس زیپ را به  ،برای زیپ

 .Displacementکردیم برای 



کند ولی قسمتهای سیاه را برجسته یا فرورفته می Bump؛ Displacementو  Bumpت تفاو

Displacement .برعکس قسمتهای سفید را 

 

 

 

 

 

 

 

 

 قسمت سی و هفت:

 کت و شلوار مردانه. طراحی پیراهن مردانه.، ی یازدهپروژه

 قسمت سی و هشت: 

 طراحی کراوات و شلوار. آموزش ساخت پاپیون.

 ه:قسمت سی و ن

 گذاریم.خطها را روی صفر می Fold Angleها. برای ایجاد خط اتو، نقاب زیپ شلوار، جیب

 قسمت چهل:

خط وسط را روی  Fold Angleکنیم، آموزش پیلی دار کردن مچی آستین. سه تا خط برای پیلی رسم می

 شود. گذاریم. بقیه را فریز کرده تا راحت تر انجامو دو خط طرفین را روی صفر می 360

کنیم. پل روی گیریم و پهنا را کمتر میمی cloneبلیطی آستین. ایجاد کمربند، از همان الگوی کمری 

 کمری. جلیقه

 قسمت چهل و یک:

 الگوی کت. اپل گذاشتن



 قسمت چهل و دو: 

 ی کت. ساخت پترن چهارخونه برای کت در فتوشاپ.ادامه

 قسمت چهل و سه:

 ذاشتن و اجرای انیمیشن.گ motionسیو کردن پوز از طریق 

زنیم، یک را می Group > groupدی مکس برای گروپ کردن همه را انتخاب کرده و از نوار بالا در تری

 اسم انتخاب کرده و اوکی.

 < Groupاجزای داخل گروه را تغییر دهیم، باز هم در نوار بالا  ungroupبرای اینکه بتوانیم بدون 

Open جام کار دوباره زنیم. بعد از انرا میClose کنیم. می 

کنیم و به باز می coronalightmtlمتریال یک  یحالت دو بعدی داشته باشد، در پنجره آواتاربرای اینکه 

 کنیم. دهیم، رنگش را کمی طوسی میآواتار می

 توان کپی کرد.در همان جهت می Xو حرکت روی محور  Shiftبا نگهداشتن 

 

 



 قسمت چهل و چهار:

 بلوز و دامن والان دار ،دوازده یروژهپ

 قسمت چهل و پنج:

 بلوز و دامن یادامه

 قسمت چهل و شش:

 ی بلوز و دامنادامه

 قسمت چهل و هفت:

 ی بلوز و دامنادامه

 قسمت چهل و هشت:

 راه و خالخالی در فتوشاپ، رندر گرفتنی بلوز و دامن، ساخت تکسچر راهادامه

 

 



 قسمت چهل و نه:

 سازی کلاه فرانسوی و یک کلاه دیگرمدلی سیزده، هپروژ

 قسمت پنجاه:

 داردو مدل کلاه لبهی چهارده، پروژه

 قسمت پنجاه و یک:

 کیف چرمی پانزده، پروژه

 



 قسمت پنجاه و دو:

 دی مکسآموزش بکگراند به دو روش در تری

 قسمت پنجاه و سه:

 دی مکس نورپردازی در تری

 قسمت پنجاه و چهار:

 رندر گرفتن از کیف چرم

 

 

 

 

 

 

 

 

 

 

 

 

 

 قسمت پنجاه و پنج:

 Avatar > Avatar Editorدی، تغییر سایز آواتار در کلو افزار کلو تریمعرفی نرم

 ها IKتغییر پوزیشن با استفاده از 



 قسمت پنجاه و شش:

 File > Export > Adobe (PDF)خروجی گرفتن از الگو در کلوتریدی 

 و تنظیمات مربوط به آن فتن در کلورندر گر

 برای اندازه گیری قسمتهایی از آواتار که مشخص نیست. Circumference Avatar tapeابزار 

 قسمت پنجاه و هفت:

Set Sublayer دهد.وقتی دو لایه پارچه روی هم باشد، جای این دوتا را در سه بعدی تغییر می 

Puckering با استفاده از نرمال مپ. مثلا درز شلوار جین که ی درزها برای ایجاد چین و چروک در لبه

 حالت جمع شدگی دارد.

Grading بندی سایز الگوهادرجه 

 Add Notchبرای گذاشتن علامت نقطه موازنه، روی پوینت راست کلیک و 

 قسمت پنجاه و هشت:

 Unwrapی لباس مجلسی که فقط در قسمتهایی طرحدار است. توضیح پروژه

را در قسمت دو بعدی زده  Edit UVدهیم. بعد کنیم و پوزیشن میدر کلو مدلسازی می اول لباس را کامل

زنیم و را می Unified UV coordinates، تیک FBXبینیم که درست باشد. هنگام گرفتن خروجی و می

 گذاریم.می 4000، اندازه را روی Texture sizeدر قسمت 

، از Modifyکنیم. لباس را انتخاب کرده، در قسمت و ایمپورت می ویمشدی مکس میبعد وارد تری

modifier list ،UnWrap UVW کنیم و بعد را انتخاب میOpen UV Editor از نوار بالا، مسیر .

Tools> Render UVW Template گذاریم و بعد می 4000در  4000ی کادر را روی رویم. اندازهرا می

 کنیم.، سیو میOverride 2/2و  JPGد گیریم. با پسونرندر می

دهیم. بعد آن را تبدیل به تغییر می 300، رزولوشن را روی Image Sizeرندر را درفتوشاپ باز کرده، اول از 

های مورد نظر کنیم. حالا روی الگوها طراحیکنیم و در ایلستریتر کپی میزمینه سفید و الگوها را رنگی می

 دهیم.را انجام می

 پنجاه و نه:قسمت 

دهیم و خود ها قرار میی الگوها را خاموش کرده، یک مربع مشکی زیر طرحبعد که طراحی تمام شد، لایه

 کنیم.اکسپورت می 400و رزولوشن بالای  PNGطرحها باید سفید باشند. سپس با پسوند 



 قسمت شصت:

را وارد کرده، بعد از قسمت سرچ،  دی مکس، در قسمت متریال پردازی، فایل سیاه و سفیددوباره در تری

وصل کرده و میکس را  Mix amountآوریم. ابتدا فایل را به را سرچ کرده و روی صفحه می Mixمتریال 

 توانیم رنگ طرحها را تغییر دهیم.کنیم. روی میکس دابل کلیک کرده و میوصل می Diffuseبه 

وصل  Displacementطرحها حالت براق داد، یا به وصل کرد و به  Reflectionهمان فایل را میتوان به 

 کرد تا حالت برجسته پیدا کند.



 قسمت شصت و یک:

 آموزش گره در مارولس دیزاینر

نامگذاری شده و از عدد یک شروع  B)کسانی که پک قدیمی را خریداری کرده بودند از این قسمت پارت 

 شود.(می

 :شصت و دوقسمت 

 Remeshing، ابزار دوخت در قسمت سه بعدی، کاربرد 8ورژن  لس دیزاینرهای جدید آپدیت ماروقابلیت

دهد تا رندر گرفتن در ها را به صورت مربع و مرتب تغییر میبدون اینکه پارتیکل دیستنس کم شود، پولیگان

 شود.دی مکس نیز راحت تر میدی مکس سبکتر باشد و ادیت کردن در تریتری

 دن چین و چروکها، برای ادیت کرSCULPTابزار 

 :شصت و سهقسمت 

کنیم که پروژه تمام شده باشد و دیگر نخواهیم ، زمانی از این ابزار استفاده میSCULPTی ابزارهای ادامه

simulate .را روشن کنیم یا پوز را تغییر دهیم 

UV Editor  توان در مارولس، در خروجی یووی هرچه الگوها بهم نزدیکتر باشند بهتر است، چون می

 تری گرفت.خروجی باکیفیت

 دیتغییرات ورژن جدید کلوتری

 :شصت و چهارقسمت 

 برای ایجاد سجاف Bindingدی، ابزار ی تغییرات جدید کلوتریادامه

 :شصت و پنجقسمت 

 دی مکس و امکانات ابتداییی محیط تریتوضیح مجدد درباره

 :شصت و ششقسمت 

 زنیم.را می F4. برای دیدن خطوط شروع آموزش یک مدل استیج کت واک ساده

را نگه  Ctrl. برای انتخاب چندین مدل Modifier Listدر قسمت  Edit poly، ابزار Planeکار با رسم 

 داریم.را نگه می Altداریم، برای حذف انتخاب می

 Extrudeبین دو خط،  Connectکاربرد ابزار 



 :شصت و هفتقسمت 

 ی دو خط به همدیگر.برای چسباندن لبه flip ،Target weldی استیج، ابزارهای ادامه

 Attachو  Detachکاربرد 

 زنیم.را از روی صفحه کلید می Gشروع یک استیج جدید، برای فعال و غیر فعال کردن صفحه گرید حرف 

 گیرد.ای را صفحه گرید در نظر میفعال باشد، هر صفحه Auto Gridاگر هنگام رسم اشکال، تیک 

، Standard Primitives، از منوی Create ،Geometry، از قسمت ProBooleanابزار 

Compound Objects کنیم، بعد را انتخاب میProBoolean  وStart Picking 

، تیک Pick Booleanهمزمان برای چند مدل استفاده کنیم، در قسمت  ProBooleanاگر بخواهیم از 

 زنیم که مدل فرعی از بین برود.را می Moveزنیم و در آخرین بار تیک کپی را می

 :شصت و هشتقسمت 

 کنیم.را انتخاب می Modifier list ،Shellشکل منحنی، از  کبرای ایجاد لبه دور ی

 Isolateی مدلها به جز یک مدل، مدل مورد نظر را انتخاب کرده، از قسمت پایین برای پنهان کردن همه

Selection  یاAlt + Q زنیم.را می 

 Hierarchy، به سربرگ Modify، کنار Command Panel، از قسمت Pivotرای تغییر دادن محل ب

، سپس محل پایوت را تغییر داده و دوباره همان گزینه. اگر بخواهیم در Affect Pivot Onlyرویم. بعد می

را  Affect Pivot Onlyو دوباره  زنیمرا می Align ،Center to Objectمرکز قرار بگیرد، در قسمت 

 کنیم.غیرفعال می

خواهیم محل اول مدلی که مییوت یک مدل دیگر قرار دهیم. ت یک مدل را در محل پیو حالا اگر بخواهیم پ

را انتخاب کرده و روی  Align، از نوار بالا Affect Pivot Onlyبعد از کنیم، وتش عوض شود انتخاب میپی

 .Okباشد و  Pivot Piontگذاریم روی ود، میشکنیم؛ یک منو باز میشکل بعدی کلیک می

 Angle Snapبرای اینکه هنگام چرخاندن یک مدل، به صورت پنج درجه پنج درجه بچرخد، از نوار بالا 

Toggle چرخانیم.زنیم و بعد میرا می 

داشتن دهیم روی کپی هم اعمال شود؛ بعد از نگه برای اینکه بعد از کپی کردن یک مدل، هر تغییری که می

Shift  و کشیدن و باز شدن منوInstance کنیم.را انتخاب می 

برای ایجاد نوشته و توضیحات  Shapesدر قسمت  Textو  Geometryدر قسمت  TextPlusابزار 

 تنظیمات مربوط به آن.



 :شصت و نهقسمت 

 Fileهای توضیح گزینه

، تعداد Scene Undoز قسمت ، اGeneral، در سربرگ Toolbar ،Customize > Preferencesاز 

 کنیم.برگشتها را مشخص می

 توانیم تنظیم کنیم.آپ ها را میتعداد و زمان بک Files ،Auto Backupدر سربرگ 

 کنیم.را انتخاب می Modifier List ،Extrudeدوبعدی بسته، از  Shapeبرای حجم دادن به یک 

توانیم ، میRendering، قسمت Modifyیمات برای حجم دادن به یک خط دوبعدی باز، از قسمت تنظ

 ای یا مکعبی بدهیم.ضخامت دایره

 :هفتادقسمت 

 ای هشت پراستیج ستاره

 ای که انتخاب کردیم.، ایجاد خط بین دو نقطهconnectاز کاربرد دیگر 

 Removeبرای پاک کردن ورتکس، راست کلیک و 



 کنیم که چه چیزی آهنربایی شود.تخاب می، روی آن راست کلیک کرده و انSnaps Toggleکاربرد 

 :هفتاد و یکقسمت 

 ی استیج ستارهادامه

ایجاد  Plane، یک Front. در نمای DWGیا  DX5دی مکس. خروجی وکتور مدلسازی لوگو در تری

 کنیم.، روی الگو خط گذاری میLineدهیم. با ابزار کنیم و در قسمت متریال عکس لوگو را به پلن میمی

 Bizier Cornerمنحنی کردن خط صاف، نقطه را انتخاب، راست کلیک و  برای

 توان جداگانه جابجا کرد.هر اهرم را می Bizier Cornerشود اما در هر دو اهرم باهم جابجا می Bizierدر 

، در Modifyهای یک شکل که با لاین کشیدیم و اکسترود کردیم، در قسمت تتنظیمات برای نرم کردن لبه

 کنیم.را زیاد می Interpolation ،Steps قسمت

 :هفتاد و دوقسمت 

 کار با موتور رندر کرونا

 کنیم.راست کلیک می Maximum Viewport، روی Layout Viewportsبرای تغییر 

، diffuse color ،Translucencyهای ، گزینهMaterial Editorی توضیح در مورد پنجره

Reflection ،Refraction 

 :فتاد و سههقسمت 

 Opacity ،Displacement ،Bumpادامه متریال ادیتور، 

 Lights .Corona sunنورپردازی و 

 :هفتاد و چهارقسمت 

Corona light در قسمت تنظیمات نور در ،Texmap توانیم عکس قرار داده و نور از آن عکس تبعیت می

 کند.می

 Render Setupی توضیح پنجره

 :هفتاد و پنجقسمت 

 Corona Material Library، دسترسی به Render Setupی تنظیمات مهادا

 :هفتاد و ششقسمت 



موتور رندر را  Render Setup، اول از HDRIکامل کردن استیج با نور هالوژن و صندلی. کاربرد عکسهای 

 Environment andی زنیم و پنجرهرا می 8ی اصلی کلید گذاریم. بعد در صفحهمی Vrayروی 

Effects شود. روی باز میNone شود، قسمت کلیک کرده، از لیستی که باز میV-Ray ،V-Ray HDRI 

 دهیم.کنیم. دوباره موتور رندر را به کرونا تغییر میرا انتخاب می( V-Ray Bitmap)در ورژنهای جدید 

Material Editor  را باز کرده وEnvironment map  را کهHDRI ر متریال انتخاب کرده بودیم د

قرار  Bitmapمورد نظر را در  HDRIکنیم. بعد روی متریال دابل کلیک کرده و فایل می dragادیتور 

 دهیم.، روی حالت کروی قرار میMapping typeدهیم. در قسمت می

 Import > Mergeی دیگر، مسیر دی مکس داخل یک پروژهی تریبرای وارد کردن یک پروژه

 toolbarآبجکتی که با یک موتور رندر دیگر ساخته شده، آن را انتخاب کرده و از  برای تبدیل کردن یک

 زنیم.را می Run Corona Converterمربوط به خود کرونا، 

 :هفتاد و هفتقسمت 

 ی استیجادامه



 None، روی Modify > IES، اول یک نور مستطیلی ایجاد کرده، بعد در قسمت IESبرای گذاشتن نور 

 کنیم.و یک نور انتخاب می کلیک کرده

Mirror  کردن یک آبجکت کپی شده از نوار بالا کنارAlign. 

 :تاد و هشتقسمت هف

ی داریم. یا مثل همه Light ،Camera، کنار Createی قرار دادن دوربین در صحنه. در قسمت نحوه

وپورت پرسپکتیو، زاویه را توانیم در ویگذاریم. یا میمدلهای دیگر با کلیک کردن و کشیدن دوربین می

دهد. اگر بخواهیم از دید دوربین نگاه کنیم بزنیم، در همان جا یک دوربین قرار می Ctrl + Cدرست کرده و 

 زنیم.را روی صفحه کلید می  Cکلید 

 :فتاد و نهقسمت ه

 اینورپردازی و متریال پردازی استیج ستاره

 :هشتادقسمت 

 دی مکسکردن در تری Importو از مارولوس  گرفتنآموزش خروجی 

 :هشتاد و یکقسمت 

 متریال پارچه نخی طرحدار

 در متریال ادیتور Color Correctionاستفاده از 

 

 

 

 

 

 

 

 



 :هشتاد و دوقسمت 

 متریال پردازی پارچه کرپ

 دهیم.می Colorیا  glossinessدر قسمت رفلکشن کاربرد دارد که به  Heightتکسچر 

، استفاده Corona Color Correctionایم، از داده Diffuseتکسچری که به  برای عوض کردن رنگ

 کنیم.می

 Levelکنیم با باشد، تکسچر را در فتوشاپ سیاه و سفید می برای اینکه پارچه کمی حالت توری داشته

 بگذاریم. box Blurتوانیم فیلتر کنیم و میمقدار سیاهی را خیلی کم می

در متریال  CoronaFrontBackنس پشت و رو متفاوت باشد، یک راه استفاده از اگر بخواهیم تکسچر و ج

 ادیتور است.

 

 

 

 

 

 

 

 

 

 

 

 

 



 :هشتاد و سهقسمت 

 متریال پردازی تور دانتل

Brusheezy.com  براش برای فتوشاپ دارد. بهDisplacement ،Opacity  وBump  وGlossiness 

 دهیم. مپ می

 کند.سیاه و سفید می Ctrl + Shift + Uدر فتوشاپ.  Normal Mapو  Normal Bump ندرست کرد

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 :هشتاد و چهارقسمت 

 ابریشمی و ساتن یمتریال پردازی پارچه

 دهیم.می Falloff، یک Mapاز قسمت  Diffuseدر متریال ادیتور، به 

 دهیم.قرار می Towards/Awayرا روی  Falloff ،Falloff Typeدر تنظیمات مربوط به 

  کنیم:نی کردن به این شکل درست می، نمودار را با ایجاد پوینت و منحMix Curveدر قسمت 

 

 

 

 

 25/0روی  Glossو  1روی  Levelدهیم، دهیم. کمی رفلکت هم میبعد رنگها را تغییر می

 5/0 تشد دهیم بابامپ هم می کبه رنگ رفلکت بدهیم.ی Falloffتوانیم از همان رنگ روشن می

، Mapی ساتن طرحداری که طرح ها از خود پارچه باشد؛ طرح باید سیاه و سفید باشد. بعد از هبرای پارچ

را به  Falloffو  Color #2دهیم. رنگ روشن را به می Mix Amountآوریم، عکس را به می Mixیک 

Color #1کنیم.تر و روشن را روشنتر می. اینجا رنگ تیره را تیره 

 

 

 

 

 

 

 

 



 :هشتاد و پنجقسمت 

 ی ابریشمی داماسک که طرحها هم مثل زمینه رفلکت ساتن داشته باشد.متریال پردازی پارچه

دهیم و می 2و  1گیریم، هر دو فالآف را به رنگهای شماره یک کپی می Falloffآوریم، از می Mixیک 

 .Mix Amountعکس سیاه و سفید را به 

Mix Curve  مربوط بهFalloff کنیم:دوم را به این شکل ادیت می 

 

 

 

 

 

کنیم و شدت را خیلی کم دهیم. عکس را به دیسپلیسمنت هم وصل میهیچ رفلکت اضافه تری نمی

 کنیم.می

 متریال پردازی بافتنی

 Corona Scatterمعرفی ابزار 

، Displacementبرای  Bump ،Height، نرمال مپ برای diffuseدر متریال ادیتور، عکس اصلی را به 

درصد و رنگ آن را مثل  80قرار داده، درصد رنگ سفید را روی  diffuseبین عکس اصلی و  Falloffیک 

 کنیم:را مثل زیر ادیت می Mix Curveدهیم. بافت ولی روشنتر تغییر می

 

 

 

 

 

یم. بعد با دهکنیم و ضخامت میرسم می پرزخطهای فنری مانند  Lineبرای پرزهای روی بافت، با ابزار 

Corona Scatter کنیم.روی سطح پارچه پراکنده می 



گذاریم و رنگ می  75/0را روی  Translucencyمتریال پرزها هم جدا، رنگ روشنتر از خود بافت و 

 دهیم.می

 

 

 

 

 

 

 

 

 

 

 

 



 :هشتاد و ششقسمت 

 متریال پردازی پارچه پشمی و جین

 در متریال ادیتور CoronaAOکاربرد 

 :هشتاد و هفتمت قس

 متریال پردازی مخمل

 شود:به شکل زیر ادیت می Mix Curveکنیم و استفاده می Falloffاز 



 

 

 

 

 

و  1کپی گرفته و به رنگ  Falloffگذاریم. از می Diffuseو  Falloffبین  Mixبرای مخمل پرز بلند یک 

 دهیم:فالآف دومی را به این شکل تغییر می Mix Curveکنیم. وصل می 2

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 :هشتاد و هشتقسمت 

 لمه شنی و لمه چند رنگ دارای طیف رنگی لمه، یمتریال پردازی پارچه

 در متریال ادیتور Gradient mapتوضیح کاربرد 

 طیف دار، باید به تعداد رنگها کرونا اسکتر داشته باشیم و از گرادینت استفاده کنیم. یبرای لمه

 

 



 :و نههشتاد قسمت 

 متریال پردازی بافت پولک دار

 کنیم.استفاده می Tubeبرای رسم پولک از 

 متریال پردازی نمد رو دوزی شده

 :نودقسمت 

 چرم و شلوار جین اپشنی کشروع پروژه

 :نود و یکقسمت 

 مدلسازی دکمه چفتکهای ژاکت

 Chamferاستفاده از ابزار 

 :نود و دوقسمت 

 و پرچ های تزئینیشلوار جین  یمدلسازی دکمه

کشیم، بعد ، دورتا دور کمری خط میLineگذاریم و با ابزار می Vertexرا روی  Snapمدلسازی کمربند، 

 Soft Selectionدهیم. ضخامت می

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 :نود و سهقسمت 

 Edit Splineدهیم بعد با کشیم و ضخامت میدوبعدی می Rectangleمدلسازی سگک کمربند. یک 

 کشیم.ی سگک را هم با لاین میتوانیم یک خط را حذف کنیم. زبانهیم

 :نود و چهارقسمت 

 ی ساخت کمربندادامه

خواهیم گذاریم و خطهایی که میمی Edit Polyدی مکس، اول روی شکل برای ایجاد خط دوخت در تری

 کنیم.جاد شود را انتخاب میروی آن خط دوخت ای



 Editدهیم، روی خط . به خط جدید ضخامت میزنیمرا می Edit Edges ،Create Shapeدر قسمت 

Spline گذاریم، ورتکسها را انتخاب کرده و در قسمت میGeometry ،Break زنیم.را می 

را باز کرده، و اندازه را کوچک  Scaleکنیم. تنظیمات همه را انتخاب می Element، و با Edit Polyبعد 

 گذاریم.می Meshsmoothشه های کوکها کشیده شود در آخر یک برای اینکه گو کنیم.می

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 :نود و پنجقسمت 

 چرم اپشنمتریال پردازی ک

کنیم. بعد یک لایه جدید ایجاد و رنگ آن را مشکی میدر فتوشاپ ی درزها، برای ایجاد حالت چروک در لبه

 هیم.دهم می Box Blur، یک  Filter > Render > Fibersمسیر 



کنیم و این را همراه تکسچر اصلی چرم سیو ی درزها را پاک میی قسمتها به جز لبهبا پاک کن همه

 کنیم.کنیم. از همین تکسچر بامپ و نرمال مپ درست میمی

 :نود و ششقسمت 

 های زیپ، زیپ، کمربند و سگکمتریال فلزی چفتکها، ماشین

 :نود و هفتقسمت 

 متریال پردازی شلوار جین

کنیم، روی برای درست کردن تکسچر جین در فتوشاپ: عکس چیدمان الگوی شلوار را در فتوشاپ باز می

 < Sketchکنیم. رنگ را روشن تر کرده و از فیلتر گالری، فیلتر آن یک لایه ایجاد کرده و رنگ آبی تیره می

Halfton Pattern 10و کنتراست  1کنیم. سایز را انتخاب می 

 Darken Only، روی filter > Stylize > Diffuseبعد از مسیر 

دهیم. و رنگ روشن را روشنتر ی قبلی میتر از رنگ تیرهی دیگر ایجاد کرده، یک رنگ تیرهدوباره یک لایه

 (7و  23) Filter > Render > Fibersکنیم و می

 70و مقدار  90دهیم. زاویه می Motion Blurروی همین لایه 

Blending Mode ن لایه را روی ایSoft Light گذاریم و میOpacity پنجاه 

 برای ساختن خط کوک در فتوشاپ: 

 Innerدابل کلیک کرده،  Textی کنیم. روی لایهبا یک فونت مناسب خط چین تایپ می Textا ابزار ب

Glow ،Inner Shadow  وOuter Glow گیریم و در قسمت درزها دهیم. بعد از آن کپی میمی

 کنیم.ن میچیدما

 : نود و هشتقسمت 

 Filterکنیم. بعد ی جدید ایجاد کرده، زمینه را مشکی میی درزها، یک لایهبرای ایجاد چین و چروک لبه

> Render > Fibers  یک 5و  20با اندازه های .Box Blur و لایه را روی  دهیمهم میSoft Light  و

Opacity 70 کنیم.می گذاریم. قسمتهای اضافه را پاکمی 

 کنیم.برای ایجاد چروکهای بزرگ محل تا شدن پا، از عکسهای آلفا استفاده می

 بود. Diffuse، اینها برای 10کمتر از  Opacityگذاریم و می Screenیا  Lightenروی 



 Opacityکنیم. برای اینکه برجستگی هم ایجاد کند، همه را سیاه و سفید کرده و زمینه را مشکی می

 Displacementدی مکس این را به گذاریم و در تریمی 70و عکسهای آلفا را روی  40ا روی درزها ر

 دهیم.می

کنیم و قسمتهای روشنتر می Levelی رویی را با ی پارچه کپی گرفته، لایهبرای ایجاد سنگشور، از لایه

 کنیم.اضافه را پاک می

 :نود و نهقسمت 

 نورپردازی و رندر گرفتن در کلو

 دی مکس را خروجی گرفته و در کلو باز کنیم.توانیم لوکیشن ساخته شده در تریمی

شکل خز را  Fur Shapeگذاریم. در قسمت می Furرا روی  Typeمتریال پردازی خز در کلو تریدی، 

 کنیم، بلندی، ضخامت، نرمی.مشخص می

 شود.فید فقط خزدار می، میتوانیم یک تکسچر سیاه و سفید بدهیم، قسمتهای سBase Mapدر قسمت 

 :صدقسمت 

 دی مکسمتریال پردازی خز و مو در تری

 کنیم.را انتخاب می Modifier List ،Hair & Furکنیم، از قسمت برای تمرین، یک پلن رسم می

 Density، اگر بخواهیم از الگوی سیاه و سفید پیروی کند مپ را به General Parametersتوضیحات 

 دهیم.می

Clumping Parametersدسته کردن موها ، 

Kink Parameters مجعد و فر دار کردن 

 :صد و یکقسمت 

 ی خزادامه

Dynamics در قسمت ،Dynamics Parameters توانیم حرکت بدهیم با تیک میLive. 

را  Multiple Objectsمتریال دادن، اگر بخواهیم در لباسی خز کار کنیم موقع خروجی گرفتن تیک 

 باشد. Textured Surfaceدهیم و روی به پارچه ضخامت نمی زنیم،می

 



 

 :صد و دوقسمت 

 دی مکسایجاد بافت سه بعدی در تری

خواهیم بافت سه بعدی باشد نگه داشته و بقیه را پاک مارولس یا کلو فقط آن قسمت از لباس که می در

کنیم و دوباره می reset 2d patternی آن را انتخاب کرده و گیریم، بعد همهکنیم و خروجی میمی

 گیریم. فقط پارچه باید در حالت بدون ضخامت باشد.خروجی می

 کنیم.دی مکس هر دو خروجی را وارد میدر تری

دهیم. این آدرس اسکریپت بافتنی را می Scripting > Install max creation graphاز مسیر 

. mesh smoothدهیم و ببینیم. ضخامت می Create > Shapes > Vuتوان در قسمت اسکریپت را می

 گذاریم.روی آن می Edit Polyبرای ادیت کردن آن یک 

 کنیم.را انتخاب می Modifier list ،Symmetryبرای گرفتن قرینه از 

گذاریم و الگوی دو بعدی را در قسمت تنظیمات می Modifier list ،Skin wrapروی بافت سه بعدی از 

 نیم.کمی Addاین 

مدل سه  Create morph targetگذاریم و از می Modifier list ،Morpherروی الگوی دو بعدی از 

 کنیم.بعدی را انتخاب می



 Convert to editable polyبرای فیکس کردن کل مدل را انتخاب کرده و راست کلیک و 

 :صد و سهقسمت 

 انیمیشن

باشد. برای سیو کردن انیمیشن از طریق  10یا  8ی برای گرفتن خروجی انیمیشن، پارتیکل دیستنس رو

کنیم. از محیط کنیم و در کلو باز میگذاریم و پروژه را سیو میکلو؛ از مارولس یک انیمیشن روی آواتار می

simulate  بهAnimation بعد از  رویم.میrecord  کردن، از مسیرfile > Video Capture > 

Animation 

ی شروع دی مکس؛ بعد از دادن یک انیمیشن به آواتار روی نقطهمیشن برای تریخروجی گرفتن از انی

گیریم. تیک معمولی با آواتار می FBXگردیم و یک خروجی برمی Simulateحرکت دوباره به محیط 

Cache Animation داریم.را برمی 

 گیریم.می Point Cache 2یک خروجی دیگر با پسوند 

 ، Modifier listکنیم. بعد فقط لباس را انتخاب کرده و از ی مکس ایمپورت میدرا در تری FBXخروجی 

point cache  کنیم. از قسمت را انتخاب میParameters  آدرس انیمیشن سیو شده راLoad 

 کنیم و فقط لباس باشد.کنیم. آواتار را حذف میمی

 کنیم.ین حرکت را باز میدی مکس مربوط به همو فایل انیمیشن تری Import > Mergeبعد 

هست. شروع و پایان را  Play ،time Configurationلاین، زیر علامت های تایمبرای زیاد کردن فریم

 توانیم تغییر دهیم.می

، Playback Typeلباس در قسمت  Point Cacheهم هماهنگ نبودند، در تنظیمات  اگر آواتار و لباس با

 کنیم تا روی آوتار قرار بگیرد.ده و شروع و پایان را تنظیم میقرار دا Custom Rangeروی حالت 

 :صد و چهارقسمت 

 display ،Hide by Category ،Boneبرای اینکه نقاط مربوط به استخوانها دیده نشود، در قسمت 

objects زنیم.را تیک می 

 Link selectکاربرد ابزار 

 کنیم.آنها را تبدیل به فیلم میگیریم و بعدا می PNGیا  JPGخروجی را با پسوند 



کردن آن، در پوزیشن اول، تایم لاین روی  Animateبرای حرکت دادن به دوربین یا هر آبجکت دیگری و 

گذاریم و ، بعد تایم لاین را گرفته و مثلا روی فریم پنجاه میSet Keyزنیم و را می Auto Keyصفر کلید 

 کنیم.را خاموش می Auto Keyینکه تمام شد کلید کنیم، بعد از ابعد دوربین را جابجا می

 :صد و پنجقسمت 

تبدیل کردن عکسها در افترافکت به فیلم و خروجی گرفتن. ادیت کردن فیلم در فتوشاپ، ادیت کردن در 

 کامتاسیا

 ی بردن آواتار کلو در سایت، دادنبرای انیمیشن های بیشتر و یا دانلود آواتار. نحوه mixamo.comسایت 

 انیمیشن و دوباره دانلود کردن آن.

 :صد و ششقسمت 

 دی مکسکیف دستی زنانه، مدلسازی یراق کیف در تری

 :صد و هفتقسمت 

 ی کیف ادامه

 



 

 

 

 

 

 

 

 

 

 

 

 :صد و هشتقسمت 

 دی مکسمدلسازی کفش زنانه جلوباز در تری

 ی کفشادامه: صد و نهقسمت 

 

 

 

 

 

 

 

 

 



 :صد و دهقسمت 

 دی.افزار کلو. طراحی بوت در کلوتریرمهای جدید نویژگی

 گذاریم.می Turnedکفش را انتخاب کرده، روی حالت  یدوختهای پاشنه Edit sewingبا 

 

 

 

 

 

 

 

 

 

 

 

 

 

 :صد و یازدهقسمت 

کنیم. یک باکس روی دی مکس باز میگیریم و در تریمی FBXبعد از مدلسازی کفی و پاشنه یک خروجی 

 یم. کنکفی کفش ایجاد می

 Objectای پیدا کند و آنطرفش را ببینیم، روی آن راست کلیک کرده، برای اینکه یک آبجکت حالت شیشه

Properties زنیم و بعد تیک را میSee-Through زنیم.را می 

کنیم. وقتی به مچ رسیدیم، کنیم و ورتکسها را ادیت میزنیم. از افقی خط ایجاد میروی باکس ادیت پلی می

Polygon کنیم، بعد کف را انتخاب کرده و پاک میBorder  دورتا دور آن را انتخاب کرده وShift  را نگه



را انتخاب کرده،  Borderکنیم تا به پنجه برسیم. برای دوباره پر کردن مقطع، داشته و چندین بار کپی می

 زنیم.را می Capراست کلیک و 

، Modifyکنیم، یک خط را انتخاب کرده و بعد در تنظیمات  ی خطهای هم راستا را انتخاببرای اینکه همه

Ring زنیم و بعد راست کلیک و را میConnectکنیم. بعد . از روبرو و دو طرف یک خط وسط ایجاد می

 گذاریم.می Mesh Smoothورتکس ها را کمی ادیت کرده، روی آن 

دی باز گیریم و در کلوتریمی FBXخروجی  بعد از اینکه مدلسازی تمام شد، دوباره از مدل پا به تنهایی

 دوزیم.ی بوت را مدلسازی کرده و روی کفی میبقیه کنیم که روی همان کفی و پاشنه قرار بگیرد.می

 :صد و دوازدهقسمت 

 ی چکمهادامه

 :صد و سیزدهقسمت 

 پایه دار مدلسازی مانکن

را طراحی کنیم و طرف مقابل خودبخود  برای اینکه فقط یک طرف مانکن symmetryاستفاده از مدیفایر 

 درست شود.

 :صد و چهاردهقسمت 

 کند.برای ساختن پایه چوبی. این مدیفایر مثل خراطی عمل می Latheاستفاده از مدیفایر 

 کنیم.استفاده می Shellاز مدیفایر  Planeبرای ضخامت دادن به 

 :صد و پانزدهقسمت 

 Editable Polyبگیریم باید همشون تبدیل به  FBXخروجی برای اینکه از یک آبجکت برای مارولس 

 .دباش Edit Poly ی آنها، یا روشوند

 Latheو مدیفایر  لایندی مکس با ساخت بیس ژیپون لباس عروس در تری

 کنیم.استفاده می Import (Add)اگر بخواهیم چند مدل در مارولس ایمپورت کنیم از 

 شروع مدلسازی لباس عروس

 

 



 

 :صد و شانزدهقسمت 

 quadرا روی  Miscellaneous ،Mesh typeتوانیم در تنظیمات قسمت به جای ریمش کردن می

 بگذاریم.

 :صد و هفدهقسمت 

 گیریم با تنظیمات:برای خروجی گرفتن از لباس، خود مانکن را پاک کرده و از لباس خروجی می

Multiple Objects, Thin, Unified UV Coordination 

 دی مکسی مدلسازی گل سه بعدی در تریروشها



 Opacityگراند سیاه و کل گل سفید به گل با بکدهیم. بعد عکس را به یک پلن می روش اول؛ عکس گل

گراند حذف شود و تکسچر بامپ از عکس گل تهیه کرده و به بامپ یا دیسپلیسمنت دهیم تا بکمی

 دهیم.می

کنیم. سگمنتهای پلن را گراند را حذف مییم و مثل قبل بکدهبه پلن میرا روش دوم؛ عکس گلبرگ گل 

 کنیم.گذاریم. از آن کپی های متعدد گرفته و چیدمان میروی آن می Bendزیاد کرده و مدیفایر 

 :صد و هجدهقسمت 

کنیم و با مروارید وسط می Convert to editable Polyبعد از مدلسازی گل، مدلسازی گل با پلن. 

Attach کنیم.و از کرونا اسکتر استفاده می کرده 

 :صد و نوزدهقسمت 

Fillet پردازی گراند و نوردرست کردن بکهای لاین. برای گرد کردن گوشه 

 :صد و بیستقسمت 

 ساخت پترن توری در فتوشاپ، سفید با بکگراند سیاه.

 کنیم.می Set IDه و برای اینکه متریال مروارید از گل جدا باشه، با المنت مروارید را انتخاب کرد

 :صد و بیست و یکقسمت 

 Displayبگذاریم. در قسمت تنظیمات  UnWrap UVWمتریال پردازی مانکن، روی هر قسمت باید 

را انتخاب کرده و خط درزها را مشخص  Selection ،Edgeداریم. در را برمی Map Seamsتیک 

 زنیم.را می Peel ،Convert edge selections to seamکنیم، بعد در قسمت می

را  Peel ،Expand polygon selections to seamsبعد با پولیگان یکی را انتخاب کرده و در قسمت 

 .Commitو بعد  Start Peltشود ای که باز می. در پنجرهPelt Mapزنیم و بعد می

 applyو  Start relaxکنیم. بعد را باز می relaxراست کلیک و تنظیمات  UVی روی الگو در پنجره

، همه را انتخاب کرده و در قسمت UV یی الگوها در پنجرهبرای مرتب شدن همه کنیم.می

Arrangement ،Pack زنیم.را می 

 Create، خط را انتخاب کرده و بعد Edit Polyبرای جدا کردن یک خط از یک مدل، در تنظیمات 

Shape From Selection شود تیک ه باز میای کزنیم. در پنجرهرا میLinear کنیم.را انتخاب می 



برای اینکه یک آبجکت را روی یک خط مشخص به تعداد زیاد چیدمان کنیم؛ آن آبجکت را انتخاب کرده و 

را زده و خط مورد نظر را  Pick Pathکنیم. را باز می Tools > Align > Spacing Toolsبعد از مسیر 

 .Applyکنیم و تعداد را مشخص می countکنیم و در قسمت انتخاب می

 

 :صد و بیست و دوقسمت 

 دیخروجی گرفتن و چیدمان الگو در ابعاد واقعی در کلو تری


